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éi';;;é:-:'f Analysis Results Current State

Analysis Ready ADaM Dataset

* : * o Static results created for Clinical

. Table 3.1.1: ADHYPO Analysis Dataset

: g & [Row[STUDYID | USUBJID EDE ASTDTM

. .": 1 XYZ | 000001 PO 1|H; 07Sep2012 2:
oo Study Report

. 4 I 2 XYZ | 000001 PO 2 | H: 0Se)

3 ..." 8 3 XYZ 000001 |HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
52 ...... ° . 4 XYZ 000001 |HYPO 4 |Hypoglycemia N 118ep2012 15:24:00
... * May be hundred of tables in PDF 5 | xvr|[omor [mrosfmarees]

S : 6 XYZ | 000002 HYPO 1 |Hypoglycemia N 220ct2012 13:28:00
' 4 . ] L]

format, often difficult to navigate 7 | e Lo fovvoslimatsoms]  x_[as0wcon 3590
§oTaad-d ) 8 XYZ 000002 |HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

« Variability between sponsors

- » EXxpensive to generate and only
used once, no or limited reusability

Static Display
cdisc



Analysis Results Current State

Table 3.1.1: ADHYPO Analysis Dataset

| Row |STUDYID | USUBJID | MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 (HYPO 1|Hypoglycemia Y 07Sep2012 22:29:00
2 XYZ 000001 [HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 |HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 [HYPO 4 |Hypoglycemia N 11Sep2012 15:24:00
5 XYZ | 000001 |HYPO 5|Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 [HYPO I |Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250ct2012 13:59:00
8 XYZ 000002 (HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset

Table 4.2.1: HbAlc Longitudinal Repeated Measures Analysis - Table Shell
Protocol: Xz Page 1 of 2
Hbalc (%) Longitudinal Repeated Measures Analysis
24-Wesk Short-tem Double-blind Treatment Period
Intention-to-treat Population

Drug & rug B
N=125 Ne125
EASELDE W 125 25
Mean (D) XK (X 30) XK (X.30%)
[ N 000 000
Change from baseline: Mean (SD) X0 (X000 XK (X000
Adjusted change £ iseline: Mean (SD) X0 (X.300) XXX (X.3000)
95% Confidence interval for adjusted mean (KKK, KK.X) (3%, XK.X)
Difference vs. Drug B (SE) RRRK (K. 30000)
5% Confidence intarval for difference 003X, XK.X)
P-value vs. Drug B
WEER 12 X3 ( X.3000 XK (X300
X3 (X000 X3 (%2000
X (X30) XXX (X.300)
Difference vs. Drug B (SE) (KKK, XK.X) (.3, XK.X)
55% Confidence interval for difference 00300 ( X.30000)
-valus vs. Drug B 00308, XK. X)
x.
T the mmber of mbjects In the Tnvention-totrest (IT3) Fopalation.
Ni: the mumber of subjects in the ITT cicn with nen-missing baseline and non-missing Wesk t value.
Repested messures medel: change = bassline tresthent viei visititrestment
Progran Source: xcncoood\aoi\soooe\t-Hbalo—repmeas  sas <date>:<tins>

Static Display

ARM for Define-XML

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metadata

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Rep d M Analysis, 24-Week Short-term Double-blind Treatment
Period, Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean. confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M V’]

ANALYSIS DATASET ADHBAIC

cdisc



Analysis Results Current State

. * ARM v1.0 describes metadata about analysis displays and results (at
- a high level), no formal analysis and results model or results data

----- * Lack of features to drive automation

« Limited regulatory use cases

« Limited traceability

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metadata

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Rep d M Analysis, 24-Week Short-term Double-blind Treatment
Period, Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean. confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE

ANALYSIS DATASET ADHBAIC

cdisc



Shifting the Paradigm

Table 3.1.1: ADHYPO Analysis Dataset
Row |STUDYID | USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 [HYPO 1 |Hypoglycemia Y: 07Sep2012 22:29:00
2 XYZ 000001 |HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
. 3 XYZ 000001 |HYPO 3 [Hypoglycemia N 10Sep2012 23:05:00
? : : 4 | XYZ | 000001 |HYPO 4|Hypoglycemia N 11Sep2012 15:24:00
5 XYZ 000001 |HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 |HYPO 1 |Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 |HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset

cdisc



Shifting the Paradigm

Table 3.1.1: ADHYPO Analysis Dataset Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata
e Row [STUDYID [USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM Metadata Field Metad
& \r ° 1 XYZ 000001 |HYPO 1 |Hypoglycemia Y 07Sep2012 22:29:00 DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1
» 2 2 DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Repeated M Anal
2 | XYZ | 000001 |HYPO 2|Hypoglycemia N 10Sep2012 09:12:00 Period, Intention-to-treat Population
L ) — RESULT IDENTIFIER Treatment difference results (LSMean, confidence interval, p-value)
3 XYZ 000001 |HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00 PARAM HbAlc (%)
4 | XYz | 000001 |HYPO4|Hypoglycemia| N 11Sep2012 15:24:00 PARAMCD HBAIC ,
ANALYSIS VARIABLE CHG (Change from baseline)
5 XYZ 000001 [HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00 ANALYSIS REASON SPECIFIED IN SAP
ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M \Y 1
6 XYZ 000002 |(HYPO 1|Hypoglycemia N 220ct2012 13:28:00 ANALYSIS DATASET ADHBAI1C
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 [HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00 ARM EXtenS|on TeChnlCaI SpeCIfI Catlon

ADaM Dataset

cdisc



Shifting the Paradigm

Table 3.1.1: ADHYPO Analysis Dataset

Row |STUDYID | USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 [HYPO 1 |Hypoglycemia Y: 07Sep2012 22:29:00
2 XYZ 000001 |HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 [HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 |HYPO 4|Hypoglycemia N 11Sep2012 15:24:00
5 XYZ 000001 |HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 |HYPO 1 Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 |HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset

ab:Observation ‘qh:hhh

1001 dm.summary

1033 gm.summary it

‘ dim.parameter | dim.sex

param.subjects
param.subjects
param.subjects
param.subjects
param subjects
param.subjects

sexALL

param.subjects  sex!

param.subjects
param subjects
param.subjects
param.subjects

dim.agocat | dim.statistic { analysisRosult
sgecalALL statfreq 100
agecat AL statfreq 60
agecat AL stat percont
agecal ALl statfreq 40
agecal AL stat percent 40
agecatALL  statfreq 50
agecalALL  statfreq 30
agecat AL stat percent &0
agecat AL stat froq 2
agecal AL stat percert 40
agecalALL  statfreq 150
stat freq %
stat percent 60
stat freq 60
stat percent 40
statfroq 100
statmean 07
stat stdev 107
stat median 370
statmin 210
tat. 660
stat freq 50
stat moan a2
stat stdev 103
stat median 360
statmin 230
tat max 670
statfreq 150
stat moan 40
stat stdov 104
stat median 370
statmin 210
statmax 670

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metad.

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Repeated M Anal
Period. Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean, confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M \Y 1

ANALYSIS DATASET ADHBAIC

ARM Extension Technical Specification

Automation

Table 4.2.1: HbAlc Longitudinal Repeated Measures Analysis - Table Shell

cd

ISC

Analysis Results Dataset

erotocol: X1z rage 1 of 2
Hblc (%) Longitudinal Repeated Measures Analysis
24-Wesk Short-term Double-blind Treatment Period
Intention-to-treat Populati
Drug & Drug B
N-12: ¥-125
BASLINE | NF 1z 125
Mean (sD) KKK (K200 KKK (KHKK)
WEEK 4 Nt
Change from baseline: Mean (SD) R (X000 XK (X000
Adjusted change from baseline: Mean (SD) KKK (X300 KKK (XHKK)
95% Confidence interval for adjusted mean (KX, KK.K) OO, KKK)
Difference vs. Drug B (SE) REKK (20000
95% Confidence interval for difference (XK, KKX)
P-value vs. Drug B x.
WEEK 12 3 XK( X.300) XXX (X300

Change from baseline: Mean (SD)
Adjusted change from baseline: Mean (SD)
95% Confidence interval £
Difference vs. Drug B (SE)

(0K, XK. X) (003X, XX.X)

95% Confidence interval for difference XK (X-300%)
P-value vs. Drug B (003X, XX.X)
X300

or adjusted mean

Reuse

Fepeated messures model:

i the bz of mbjacte In the Intention totrest (I77) Population.
N: the mmber of subjects in the TTT populaticn
change

Program Source: x0000000(\10000\2000¢\t-hbal o repmeas .sas

with non-missing baseline and non-missing Wesk t value.
= baseline treatment visit visititreatment
<date>:<time>

Traceability

Display



Analysis Results Desired Future State

AN * Formal model for deSCt‘ibing . Support Storage, access,

W analyses and results as data processing and reproducibility of
..+ Facilitate automated generation of results

results

_ _ * Traceability to Protocol/SAP and to
o« From static to machine readable input ADaM data

- Improved navigation and reusability * OPen-source tools to design,
of analyses and results specify, build and generate

analysis results

cdisc



Analysis Results Standards Goals

k] @ Analysis Results Metadata Technical Specification
b (ARM-TS), to support automation, traceability, and
creation of data displays

i III Define an Analysis Results Data (ARD) structure, to
: support reuse and reproducibility of results data

y« lllustrate and exercise ARD and ARM-TS with a set of
\ machine-readable common safety displays

cdisc



5?;;;:-:35? Key Metadata Elements of a Table

Y e : TITLE
e Display Template Title subtitle ) | Analysis Set
? : ' (Subtitle 2) D|Sp|ay
.. Analysis :,roup Heading 1 Heading 2 Heading 3 Heading 4
i i~ I ——— <-straddle->-------mmmmmmmmmmaeeo
. . Column 2 Row ]
N @
' Body
s Legend | Legend
e Abbreviations | Abbreviations D|Sp|ay
Pl Footnote Footnote

Reference: PHUSE White Paper “General Output Tips and Considerations”, Doc ID: WP-034, Version 1.0, Aug 2020

cdisc



Demographics Analysis Results and Metadata

Display Template Title Analysis Set

e e Table 2. Baseline Demographic and Clinical Characteristics, Safety Population, Pooled Analyses (or Trial X)
Seeili Drug Name Drug Name Total
Analysis Group DasageX  IDosage ¥ Plscibo MctveiCorirdl  Fopulstion
Dot Characteristic n (%) n (%) n (%) n (%) n (%)
L Sex, n (%) n (%) n (%) n (%) n (%) n (%)
S Male n (%) n (%) n (%) n (%) n (%)
A Female n (%) n (%) n (%) n (%) n (%)
g Age, years XX (Y.Y) XX (Y.Y) XX (Y.Y) XX (Y.Y) XX (Y.Y)
Mean (SD) XX (YY) XX (YY) XX (YY) XX (YY) XX (YY)
Median (min, max) XX(Y.Y,Z2.2) XX(Y.Y,Z2.2) XX(Y.Y,Z2.Z) XX(Y.Y,Z2.2) XX(Y.Y,Z2.Z)
Age groups (years), n (%) =_L0/)) =0/ =L/ = L0/ n (%)
217 to <65 Result ) Result Where Result n (:;0)
§§§ to <75 Group ; Variable Clause Statistics 2 50/3
275 n (%) n (%) n (%) n (%) n (%)
Race, n (%) n (%) n (%) n (%) n (%) n (%)
American Indian or Alaska Native Asian n (%) n (%) n (%) n (%) n (%)
Black or African American n (%) n (%) n (%) n (%) n (%)
Native Hawaiian or Other Pacific Islander n (%) n (%) n (%) n (%) n (%)
White n (%) n (%) n (%) n (%) n (%)
Other n (%) n (%) n (%) n (%) n (%)

Source: [include Applicant source, datasets and/or software tools used].
' Difference is shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
Abbreviations: N, number of patients in treatment arm; n, number of patients with given characteristic; SD, standard deviation

Footnote Abbreviations Legend

cdisc



Analysis Results Dataset Example: Demographics

Identifiers Analysis Group Result Variable Results Statistic
Name Title Dataset | Variable Value Variable | Value | Label | Value | Name | Label
Baseline Demographics and
.. . Drug Name
Table 2 | Clinical Characteristics, Safety [ ADSL TRO1X Dosage X SEX M Male 53 Count n
Population &
Baseline Demographics and
.. . Drug Name
Table 2 | Clinical Characteristics, Safety | ADSL TRO1X SEX M Male 61.6 Percent %
. Dosage X
Population
Baseline Demographics and
.. . Drug Name
Table 2 | Clinical Characteristics, Safety | ADSL TRO1X Dosage X SEX F Female 33 Count n
Population &
Baseline Demographics and Drue Name
Table 2 | Clinical Characteristics, Safety [ ADSL TRO1X Dois;a e X SEX F Female | 38.4 | Percent %
Population &




b Analysis Results Dataset Example: Demographics

¢ ) e
bl Identifiers Analysis Group Result Variable Results Statistic
ot o
E e Name Title Dataset | Variable Value Variable | Value | Label | Value | Name | Label
‘ “““ H Baseline Demographics and
L . . Drug Name
S Table 2 | Clinical Characteristics, Safety | ADSL TROIX Dosage X SEX M Male 53 Count n
Population &
W Baseline Demographics and
#:-::¢ [ Table2 | Clinical Characteristics, Safety |  AD TROIX EX M Male 1. Percent A
S e . Dosage X
il Population
e Baseline Demographics and
.. . Drug Name
Table 2 | Clinical Characteristics, Safety | ADSL TRO1X Dosage X SEX F Female 33 Count n
Population &
Baseline Demographics and Drue Name
Table 2 | Clinical Characteristics, Safety [ ADSL TRO1X Doga e X SEX F Female | 38.4 | Percent %
Population &

Traceability to the underlying ADaM dataset



Machine Readable TFL Shells

. [ ] 1 2xml oding="UTF-8"2>
s 5 2 <TableShell>
- : 3 ID>TEAE.01</ID>
s @ 4 <Ordinal>1</Ordinal
. R s <Type>Table</Type>
By vi0nsn 9B [ <Name>TEAE-Overall</Name>
: : : 7 <Title>Overall Summary of Treatment Emergent Adverse Events</Title> Adverse Events
@ 8 <Population>Safety Population</Population>
" s <ColDefs
0 TreatmentVar "TRTOL" ngn "ST.0 Table 35. Patients With Adverse Events' by System Organ Class, Safety Population, Pooled Analysis (or Trial
1nv <ComputeCols> Drug Name Drug Name
12 <ComputeCol all" "ST.01" Dosage X Dosage Y  Active Control Placebo Risk
12 /ComputeCols: N = XXX N = XXX N = XXX N = XXX Difference (%)
14 </ColDefs> System Organ Class n (%) n (%) n (%) n (%) (95% CI)*#
15 b <ResultGroupDef "ERE.01.GRP.0L" "L Blood and lymphatic system n (%) n (%) n (%) n (%) PANNZ),
19 b <ResultGroupDef "IERE.OL. oz "2 _Cardiac disorders n (%) n (%) n (%) n (%) X(Y,2)
2p <ResultDef "IE.}E 01.GRP. ‘:wl.RESqu" {4 lines] Ear and labyrinth disorders n (%) n (%) N (%) N (%) X (Y, 2Z)
27 <ResultDef "TEAE.01.GRP.01.RES.02 “Endocrine disorders n (%) n (%) n (%) n (%) X (Y, 2)
28 Label :fub;.eccs with a related AE</Label> Eve disorders n (%) n (%) n (%) n (%) X(Y,2)
= StatRes o Gastrointestinal disorders n (%) n (%) n (%) n (%) X(Y.2)
. et oT.02 Hepatobiliary disorders n (%) n (%) n (%) n (%) X(Y.2)
e "R ES\; ; == TERE.01.CRE. 03 RES. 01" Immune system disorders n (%) n (%) n (%) n (%) X(Y,2)
esulrhes SOL-GRE.D2.RES.O Infections and infestations n (%) n (%) n (%) n (%) DANAZ),
33 Label>Number of AEs</Label> i e — o 5 = 5
” seatmes P Injury, poisoning and procedural complications n (%) n (%) n (%) n (%) X (Y, 2)
N e Source: [include Applicant source, datasets and/or software tools used].
35
</ResultDef " Treatment-emergent adverse event defined as [definition].
®v <StatDef "ST.0L" N> 2 Duration = [e.g., X week double-blind treatment period or median and a range indicating pooled trial durations).
a7 <Label>Number of Subjects</Label> # Difference is shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
28 Formats>XX</Format> “Table display is ordered by the risk difference.
- Cstatmers Abbreviations: Cl, confidence interval; N, number of patients in treatment arm; n, number of patients with at least one event
v <StatDef "ST.02" "PCT">
41 <Label>Percentage of Subjects</Label>
42 Format> (XX.X$) </Format>
a2 </StatDef>
44 </TableShell
45

Develop schema for machine
readable TFL shells

cdisc



Current Analysis Data Flow

CDASH SDTM ADaM

(Collection) = (Tabulation)

Analysis

Results

(Analysis)

Adverse Events

Table 35. Patients With Adverse Events’ by System Organ Class, Safety Population, Pooled Analysis (or Trial X)*

@ Drug Name
. . Dosage X DosageY  Active Control Placebo Risk
’ N = XXX N = XXX N = XXX N=XXX Difference (%)

.9 System Organ Class n (%) n( n( n (%) (95% CI)*4

s Blood and lymphatic system n n n( n X(Y,2)
% Cardiac disorders n ( n ( n n X(Y.2)
e ar and labyrinth disorders n( n n( n ( X(Y,2)
ine disorders n ( n( n n X(Y,2)
ye disorders n( n n( n ( X(Y,2)
intesti n n ( n n( X(Y.2)
. y disorders n ( n( n( n( X(Y,2)
ke mmune system disorders n( n ( n n X(Y.2)
. Infections and i i n ( n ( n( n ( X(Y,Z)
Injury, poisoning and procedural complications n n n (%) n( X(V.2)

Source: [include Applicant source, datasets and/or software tools used],

" Treatment-emergent adverse event defined s [definition].

2 Duration = [e.g., X week double-blind treatment period or median and a range indicating pooled trial durations],

* Difference is shown between [treatment arms] (e.g.. difference is shown between Drug Name dosage X vs. placebo).

“ Table display is ordered by the risk difference.

Abbreviations: Cl, confidence interval; N, number of patients in treatment arm; n, number of patients with at least one event




End Goals: Streamline Analysis Data Flow an
Reducing Unnecessary Variability

Standardized Metadata

CDASH SDTM ADaM

(Collection) o (Tabulation)

Analysis

Results

(Analysis)

9
& el oo
AP cdisc (TT1 [ TT 1] Adverse Events
® @ Ste Narmber
. Table 35. Patients With Adverse Events’ by System Organ Class, Safety Population, Pooled Analysis (or Trial X)*
@ Drug Name
Dosage X DosageY Active Control Placebo Risk
EormiAE ZAdverse Events N 2 00K N e 0 N = XXX N=XXX Difference (%)
9 1 AE - Adverse Events System Organ Class n (%) n (¢ n( n (%) (95% CI)*4
> Blood and lymphatic system n n n n X(Y,
3 - 11 |Were aﬂg;‘;efse events | No AEYN Cardiac dis‘t’wrd‘;rs - n ; n§ n : n{ X :Y ;
e .. ke o Yes ar and labyrinth disorders n( n( n( n( X(Y.2)
12 |Whatis the adverse event ine disorders ni( n( n( n( X(¥.2)
3 om? AETERM vo disorders o n n n X(Y.2)
- n n ( n( n ( X(Y.2)
. 13 [Start Date AESTDAT iliary disorders n n n( n X(Y,Z)
°: (EDMMMEYYYY) mmune system disorders n ( n(’ n n ( X(Y.2)
o 14 |ongoing O No AEONGO nfections and i i — n n n n X(Y.2)
0w Yes Injury, poisoning and procedural complications n n n (%) n X(Y.2)
| DR Source: [include Applicant source, datasets and/or software tools used].
15 End Date AEENDAT 1 Treatment-emergent adverse event defined as [definition].
(DD-MMM-YYYY) LI_|_I_|_|_|_J_J_’ 2 Duration = [e.g., X week double-blind treatment period or median and a range indicating pooled trial durations].
* Difference is shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
i i . “Table display is ordered by the risk difference.
5 [saiy O e Mild AESEV Abbreviations: G, confidenge interval; N. number o patients n treatment arm; n, number of patients with at least one event
 swcenrs Moderate
© ous Severe




ARS will drive automation and open-source tool
development

cdisc
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a0
CE

OOI/RCE }‘\»\?

TFL Designer

» Open-source tool to design tables, figures, and
listings (TFL) and generate associated metadata to
support clinical trial data analysis and reporting

* MIT license

» CDISC COSA approved

18



[ X ] “
disc <y
LIBRARY

Analysis Results
Standards
(ARM-TS &
ARD) & TFL
Display
Templates

'''''' e  Sclect TFL of Interest

Sponsor Industry Standards
IR Study
D VDR Sponsor Standards
Study Definitions

e ——— - — - I e

Select Analysis

ﬁ Concepts, Methods,
5 Terminology & TFL
an Display (Template)
L W
O
Ao .
5 H”} ; Customize TFL Layout
I & Metadata

Machine-readable ARM

+ TFL Shells

N o e e e e e e e e = =T

* Open-Source TFL Designer, Bhavin Busa
Link to GitHub: https://github.com/bhavinbusa/tfldesigner

Protocol,
CRF &

19


https://github.com/bhavinbusa/tfldesigner

Sponsor Use Case
Current TFL Process

?:7. : E it Treatment Difference | = PE0) ADAM
g s mon S " ADSL and ADTTE
.
i T N ’ — ===
- — ° -’
7
7
e
/7
7/
/
/
; /
., /
‘ /
II \
! \
| 1 \ \
1 \ \
1 1
1 1

I
1 I
I
v
In-Text Table Exploratory Analysis Journal Publication Labeling

cdisc 2



Sponsor Use Case
Current Process

* Downstream groups must rely on programming needs to create all outputs
» Must re-create complex analysis each time from ADAM datasets

* Increased chance for error, added time, and bottleneck in programming
group

cdisc

21



. Sponsor Use Case
"~ ARD Process

ment Diffsrence (1zg vs P50)

ADAM
ADSL and ADTTE

|oEEE HEE HEEP

S T e el - ARMTS and
- Analysis Results
» Dataset

Bayesian Table Bayesian Graph

\
\

\
v

Exploratory Analysis Labeling

cdisc 2



Sponsor Use Case
ARD Process

Treatment Difference (Jzx vs PEO)

RESULTTYPE2  RESULTTYPE3 RESULTTYPE4 RESUI
Posterior Posterior Mean Observed XXX
Observed Change Difference B(LY - Effect Observed XXX
Treatment Timepoint n Mean (SD) Mean (SE*) Mean Change(S5% CrI) ({55% CrI) PBO <0) Size Observed o
Placebe Week 2 XX XX XX (X.XX) XXX (X.XX)
(N=XX) Week 2 XX KK.KK(X.XK) KX XK(X.XK)  XK.XX(XX.XX, X. Observed XXX
Week 11 XX XK XX (X XK) KKK (X XX) XK KX (KXXX, X. Observed XXX
Observed XXX
2 Week 2 XX XX XX (X.XX) XX XX (X.XX) Observed XXX
(N=XX) Week & XX XX XX (X.XX) XX XX (X.XX) XXX (LXK, X. (EXLXX, X.XX) X. 0o XLXXX Observed XXX
Week 11 XX XX XX (X.XX) XXX (X.XX) XXX (LXK, X. (LXK, X.XX) X. XX XK XXX Observed XXX
Response Rate Posterior XXX
;‘{‘ B flesk 2 x XXX (X.34) XX.XX (X.3x) Resgonse Rate Posterior XXX
(N=XX) Week & XX XX XX (X.XX) XXX (X.XX) XXX (XXLXX, X.XX) (XX XX, X.XX)
Week 11 XX KK KX (X.XX) KK XX (X.XX) KX KX (EXL KX, X.XX) (XXX, X.XX) Ssponse Rate Posterior XXX
Respol XXX
o Tme - -7 s T N - <z week'Z zris : * pasenfie Staerr Response Rate XXX
ol 2 2 W‘\ natﬂmﬂ m Ro.
8 Week 8 1TrtA Change from Baseline 95% Cl High Response Rate Posterior XXX
8 Week 8 2TrtB Change from Baseline 95% Cl High Response Rate Posterior XXX
8 Week 8 3 PBO Change from Baseline 95% Cl High Response Rate Posterior XXX
8 Week 8 1TrtA Change from Baseline 95% ClLow Response Rate Posterior XXX
8 Week 8 2TrtB Change from Baseline 95% ClLow Response Rate Posterior XXX
o 8 Week 8 3 PBO Change from Baseline 95% ClLow Response Rate Posterior XXX
1.00 8 Week 8 1TrtA Change from Baseline Mean Response Rate Posterior XXX
8 Week 8 2TrtB Change from Baseline Mean Response Rate Posterior X)y.
§ H‘m g TPEC T Tor RRX
g 000 e 8 Week 8 1TrtA Change from Baseline 95% Cl High Response Rate Posterior Difference | XXX
< 8 Week 8 3 PBO Change from Baseline 95% CI High Response Rate Posterior Difference | XXX
E 100 eek 8 1TrtA 3 PBO Change from Baseline 95% ClLow Response Rate Posterior Difference | XXX
% 8 Week 8 2TrtB 3 PBO Change from Baseline 95% ClLow Response Rate Posterior Difference | XXX
% 8 Week 8 1TrtA 3 PBO Change from Baseline Difference Response Rate Posterior Difference | XXX
;% -200 8 Week 8 2TrtB 3 PBO Change from Baseline Difference Response Rate Posterior Difference | XXX
& 8 Week 8 1TrtA 3 PBO Change from Baseline EffectSize Response Rate Posterior Effect Size | XXX
300 8 Week 8 2TrtB 3 PBO Change from Baseline EffectSize Response Rate Posterior Effect Size | XXX
3 T T T T 3 >y " 8 Week 8 1TrtA 3 PBO Change from Baseline EOI<0 Response Rate Posterior Probability | XXX
Study Timepoint 8 Week 8 2TrtB 3 PBO Change from Baseline EOI<0 Response Rate Posterior Probability { XXX




Sponsor Use Case
ARD Process

* Downstream groups can easily consume Analysis Result Dataset directly
without relying on programming group

» Complex analyses done once

» Decreased chance for error, more efficient use of time, and less reliance on
programming group for downstream activities
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In Conclusion

* Industry-wide CDISC model to support analysis results metadata technical
specification (ARM-TS) and analysis results data (ARD)

» Streamlined analysis data flow — keeping end in mind (TFL - ADaM ->
SDTM - CRF)

» Perform each analysis once
» Pro-actively discuss with Regulatory agency if ARD is intended

» Open-source tool development

cdisc
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